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Introduction

Transform Data is a Format tool that enables a new structure to be created from an existing XML or recordset data

source. The output generated by this tool is ready for use in a destination system which consumes or requires XML.

You can use this tool where a requirement exists to manipulate data into a customised structure such as, flattening

or merging areas of content.

Features

4 Consume XML or recordset data from existing steps as the input
4 Create custom XML schemas for output to other tools

4 Replicate the schema of the input data source

4 Output to other tools in XML format
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Working With Other Tools

The Transform Data tool can directly interact with the following tools:

Consuming from Other Tools
The Transform Data tool can directly consume output from the following tools:

lcon ‘ Tool Name Tool Category

Call Stored Procedure (OLEDB) Input, Data Connectors, Output, and Execute

Database Query (OLEDB) Input and Data Connectors

Import XML Document

Convert Recordset to XML Format

Transform Data Format
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Icon ‘ Tool Name Tool Category

Filter Data General

Objects Consumed

The following objects, outputted by the above tools, can be directly consumed by the Transform Data tool:
4 XML — XML data from any BPA Platform tool capable of exposing such data (see above)

4

Recordset — Tabular data from any BPA Platform tool capable of exposing such data (see above)

Exposing to Other Tools
The Transform Data tool output can be directly consumed by the following tools:

Icon ‘ Tool Name Tool Category

Retrieve Text Message

Run Microsoft Reporting Services Format

Call Task Execute
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Objects Exposed
The Transform Data tool outputs the following objects which can be directly consumed by the above tools:

4 OutputXML — This object exposes two sub-objects:

O XmlString — This is the XML produced by the Transform Data tool at task run-time.

O XmlSchema — This the XSD schema for the XML output.

4 ErrorXML — This object exposes two sub-objects:
O XmliString — This XML document contains any error data reported back from the consuming task
step. All errors are created as an <ERROR> node with the following child nodes:
<CODE /> — The returned error code.
<MESSAGE /> — The corresponding error message.
<INPUTDATA />— The input data that was sent which caused the error.

O XmiSchema — This the XSD schema for the XML output.

4 CustomXMLOutput — This is the XML produced if you have requested custom output XML (see Output Data

Structure Settings).

4 Step Properties — Standard step properties are available allowing you to use statistical data of the tool

Global Configuration

The Transform Data tool does not require any global configuration, and can be used in a task immediately.

Step Configuration

To add a new Transform Data step to an existing task, you either:

4 Click and drag the Transform Data icon from the Task Browser to the task Design area.

4 From the task's Design tab, right-click on empty space and select New > Format > Transform Data.

For a detailed description of how to create new tasks, refer to the product help.
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About the General Tab

@ Transform Data

General Main  Mapping Options

Mame: |Transform Data

Description:

Data source
() No data source
(@) Use a recordset or XML source from another step

Input Source; v |

0K | Ccancel |

The General tab is used to enter the following details for the step:

4 Name — Enter a meaningful name for the step

TIP: If this task instance makes use of two or more Transform Data steps, ensure the Name used is unique for

each individual step.

4 Description — If required, enter a description of this step

Data source can either be:

4 No Data Source — This allows you dynamically create the required XML document in the step itself — you do

this in the Main tab

4 Use a recordset or XML output from another step — Enable this parameter if recordset data or an XML

document from a previous task step is to be transformed

O Source — Contains all available inputs from steps previously created in the task
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About the Main Tab

The Main tab is used to design your required XML structure for output.

@ Transform Data

General Main  Mapping Options
Tip:
The output XML data structure is defined here. This can be manually defined in the design area below ar imported from a

saved XML or X5D file. It is also possible to replicate the structure from the step's input source; this can then be edited if
required.

Output Data Structure

Replicate structure from input data source

Structure:
(=1 NewMode1 i Name NewNode 1
= NewHement1 minQOccurs 1
i @Newtrbute1 - maxCiccurs unbounded
| AddNode | | AddElement | | AddAtribute | Name -
Enter the name of this item in the output
| Impaort | | Remove | | Expaort |

oK || Cancsl

Defining the XML Structure

The structure you create here appears in the Mapping tab and is ultimately made available to subsequent steps in

the task. You can create this by doing one of the following:

4 Replicate the structure from the input data source — If using an input source from a previous task step,

you can replicate the already provided XML structure or use the recordset column names as the XML

elements

4 Import an existing XML structure — If you have an existing XML or XSD file containing the XML structure you

would like this task step to use, click Import to replicate the structure

4 Manually create the structure from scratch — Use Add Node, Add Element, and Add Attribute to manually

create the required XML structure
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If required, click Export to use the final XML structure defined here in another Transform Data task step, or as a

backup.
Defining XML Properties
Irrespective of the method used, additional configuration is required for the node, elements, and attributes:

> Name — The name of the node, element, or attribute.

> minOccurs
O If a node, this is the minimum number of times this node can appear in the final output.
O If an element, this is the minimum number of times this element can appear in its parent node.

O If an attribute, this is the minimum number of times this attribute can appear itits parent element.

4 maxOccurs
O If a node, this is the maximum number of times this node can appear in the final output.
O If an element, this is the maximum number of times this element can appear in its parent node.
O If an attribute, this is the maximum number of times this attribute can appear it its parent element.

Use Unbounded to indicate an unlimited number of appearances.

4 Type — Only available for attributes. This is the data type of the attribute; standard data types are available.
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About the Mapping tab

The Mapping tab uses the Data Transformation Layer (DTL) to define links between the input XML or recordset data
and the new XML output structure generated at runtime.

B Transform Data

General Main  Mapping  Options
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The left-hand Input Data pane reflects the current structure of the data source — if you see "No schema has been
loaded" you can create the input source in the Transformation Mappings pane by assigning variables to a Fixed /
Dynamic function (refer to the product help). The Output Data pane on the right reflects the designed XML

structure from the Main tab. To create a mapping, drag an element from the left pane on to an element in the right

pane.

From here you can:

4 Automatically map where input and output parameter names match

4 Create mappings from a set of transform functions to change the data between input and output
4 Use nested looping to support hierarchical data structures

4 Import and export mappings so that they can be reused in other steps

For a detailed description of how to map data in this tab, refer to the product help.
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About the Function Types

A number of functions are available with the Data Transformation Layer (DTL):

General Main  Mapping  QOptions
Input Data Transformation Mappings
D Search: l:l E E E @ f& | E|--- Functions
=3 InputData » 4 =-I] Agaregation
: MNode Count
=3 Row 4 4 S
> S5N_C 4 -2 Sum
<> SSN_C BB Data
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Aggregation Functions
Aggregation functions define operations for specific nodes.

The Node Count Function

This function counts the number of occurrences of a node in the input recordset or XML document. The result is then

passed to the mapped output node.

The Sum Function z

This function calculates the total of the values from all iterations of an element in the input recordset or XML

document. The sum of the values is used as the new value to an output element.
Data Functions

Data functions perform operations on input data to generate new output data.
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The Fixed / Dynamic Function

This function passes a static or dynamic value to the output XML schema. Use a variable or recordset column to

generate the dynamic data.

The Run VBScript Function E

Use this function to perform VBScript operations to process input data, generate output data, or both.
Lookup Functions
Lookup functions are used to find values in a nominated source, by a key.

The External Lookup Function @

Use this function to lookup values from an external database. This uses existing Database Query (ODBC) or
Database Query (OLEDB) global connections.

The Internal Lookup Function

Use this function to find an alternative value for input data from a predefined lookup table.
Looping Functions

Looping functions loop through the input recordset or XML document to perform functions on all iterations of a node.
i

The Interleaved Merge Function &

This function loops through the input recordset or XML document and merges data from specified elements into a

single occurrence for the mapped output data.

The Simple Loop Function nE

This function loops through the input recordset or XML document and creates an output data node for every iteration
of an input node it finds.
L=l

The Split by Type Function'®-e

This function is the opposite to the Interleaved Merge function in that it takes data from a single input node and splits

it into two or more output data nodes.
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About the Options Tab

The Options tab allows you to define how errors in this step are handled at task runtime.

B Transform Data

General Main  Mapping Options

If an emaor occurs:
(@) Abort Step
(") Continue

If step aborted:
(®) Abort Task

() Continue

Output Data Stucture settings:
Output raw XML

[] Set custom header node

Cares

If an error occurs, you can decide whether the step should Continue processing, or terminate the step immediately
(Abort Step).

If the step is aborted, you can choose to Continue processing onto the next step in the task, or terminate the
whole task immediately (Abort Task). By allowing the task to continue, you can use the error XML received back in a
Save File step for investigation purposes, for example.

By default, the XML document is outputted with <OutputData> as the header node with a standard namespace
declared. If required, you can choose to output the XML with no namespace declaration or with a custom header

node. This is particularly useful if you want to directly use the XML in an external system.

To change the Output Data Structure settings, enable Output raw XML — this setting alone removes the
namespace declaration. If a different header node is required, enable Set custom header node and specify it below
(to use no header node, leave this blank). In either circumstance, use the CustomXMLOutput property rather than
the OutputXML property when saving the output to file — see CustomXMLOutput Property.
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